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Manual de instalación 

 

 

1 XAMPP 

Recordemos que XAMMP era una herramienta para "emular" un servidor en 

nuestro propio ordenador, de forma local, desarrollada por Apache Friends. Lo 

que hace XAMPP es instalar un servidor Apache con MySql como gestor de 

base de datos, PHP como lenguaje de script del lado del servidor y también 

cuenta con el lenguaje de programación Perl (en este proyecto no es usado).  

Gracias a esto, es posible desarrollar el proyecto al completo de manera local, 

sin necesidad de disponer de servidores remotos. Dicho todo esto nos 

disponemos a instalar XAMPP en Windows. 

 

1.1 Instalación de XAMPP 

La siguiente instalación vamos a dividirla en una serie de pasos: 

PASO 1: Descarga de XAMPP 

Aunque dentro de la documentación del proyecto se incluye el ejecutable para 

poder instalar XAMPP en Windows para el ordenador, se van a indicar los 

pasos por si el lector desease descargar el ejecutable para otro sistema 

operativo como Linux o Apple, o bien porque pasado un tiempo quizás la 

versión incluida en la documentación quedase obsoleta y en la URL que se 

indica a continuación se puede encontrar la versión más reciente. 
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Así pues, desde la siguiente URL [https://www.apachefriends.org/index.html], 

se puede encontrar la versión más reciente y para todos los sistemas 

operativos: 

Ilustración 1: Pagina versión descarga XAMPP para S.O. deseado 

Al pulsar sobre la opción deseada, nos saldrá la siguiente página: 

Ilustración 2: Inicio descarga de XAMPP. 

Inmediatamente comenzará la descarga del ejecutable de XAMPP; si esto no 

ocurriese, pulsar sobre “click here” de la página anterior. 
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Una vez descargado el ejecutable, buscarlo en la carpeta de descargas y hacer 

doble click sobre él. 

Ilustración 3: Carpeta “descargas” donde se encuentra el ejecutable de XAMPP. 

Como puede observarse, se ha instalado la versión más reciente para 

Windows, la versión 1.8.3. 

PASO 2: Instalación de XAMPP 

Al hacer doble click sobre el ejecutable descargado, comenzará la instalación 

en sí. En primer lugar saldrá la siguiente pantalla de instalación: 

 

 

 

 

 

 

 

Ilustración 4: Inicio de la instalación. 
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Al pulsar sobre ejecutar, comienza la instalación,  apareciendo: 

 

 

 

 

 

 

 

 

Ilustración 5: Primera pantalla de instalación 

Debemos pulsar sobre “Next” para continuar, para poder elegir en la siguiente 

pantalla de instalación qué opciones deseamos instalar en el equipo: 

 

 

 

 

 

 

 

Ilustración 6: Elección opciones a instalar. 
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En nuestro caso necesitaremos instalar, en cuanto a servidores, tanto el 

servidor Apache, así como MySQL, los cuales son los que se usan para la 

ejecución de consultas de la aplicación. Además serán necesarios los 

lenguajes de programación PHP, que es usado para los script del servidor 

Apache que realiza las consultas a la base de datos, así como PhpMyAdmin, 

mediante el cual hemos creado y desarrollado nuestra base de datos al 

completo. 

Tras esto, debemos seleccionar la carpeta donde deseamos sea instalado 

XAMPP, tal como muestra la siguiente ilustración: 

 

 

 

 

 

 

 

 

 

Ilustración 7: Carpeta donde instalar XAMPP. 

Al pulsar sobre “Next” comienza la instalación con todas las opciones que 

hemos elegido en el procedimiento anterior. 
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PASO 3: Iniciar XAMPP 

Una vez ha concluido la instalación de XAMPP podemos iniciar la ejecución del 

programa pulsando sobre el icono que se encuentra en el escritorio, o bien 

buscándolo en el directorio donde el usuario deseó su instalación, en nuestro 

caso C:/XAMPP. La pantalla que aparecerá será: 

Ilustración 8: Pantalla inicio XAMPP. 

Como observamos, solo aparecen las opciones instaladas, en nuestro caso, el 

servidor Apache y el servidor MySQL, los cuales pueden ser iniciados pulsando 

“Start” y administrados pulsando sobre “Admin”, una vez estos son arrancados. 

 

1.2 Inicio de servidores 

Como se ha indicado, para iniciar los servidores tan solo se debe pulsar sobre 

“Start” en ambos casos, pudiéndose inmediatamente administrar ambos. Desde 

el mismo momento en el que son iniciados, se les asignará a cada servidor un 
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PID y un número de puerto para su ejecución, tal y como muestra la siguiente 

ilustración: 

Ilustración 9: Servidores Apache y MySQL iniciados. 

 En los próximos 2 apartados se mostrarán como administrar cada uno 

de los servidores iniciados, mostrando sus características principales: 

 1.2.1 Servidor Apache 

 Botón “Admin” 

 Para poder administrar el servidor Apache debe pulsarse sobre dicho 

botón, que se encuentra junto a otros botones: 

Ilustración 10: Detalle botón administrar servidor Apache. 
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 Una vez se pulsa sobre dicho botón “Admin”, automáticamente se abre 

el navegador de internet con la dirección local (http://localhost), mostrándose: 

Ilustración 11: Pantalla administración Apache. 

Mediante esta página, es posible administrar casi cualquier aspecto de Apache, 

tales como seguridad, estado del servidor, documentación del servidor así 

como los componentes de los que dispone. Como puede observarse en la 

ilustración anterior, se puede acceder a todas estas opciones tan solo pulsando 

sobre la elección pertinente en la parte izquierda de la pantalla. 

Por ejemplo, si pulsamos sobre “estado” del servidor, aparecerá lo siguiente: 

Ilustración 12: Detalle “estado” del servidor. 

http://localhost/
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Como puede observarse en la ilustración, vemos que está activada tanto la 

base de datos MySQL, así como el uso de PHP o HTTPS (SSL). 

 Botón “Config” 

 Si pulsáramos el botón “Config” en la pantalla de inicio de XAMPP en 

cuanto al servidor Apache, aparecerá un menú con todos los archivos 

configurables del servidor, tales como: 

 httpd.conf (Configuración Apache). 

 httpd-ssl.conf (Configuración Apache). 

 httpd-xampp.conf (Configuración Apache). 

 php.ini (Configuración PHP). 

 config.inc.php (Configuración PhpMyAdmin). 

Esto puede observarse en la siguiente ilustración: 

Ilustración 13: Detalle al pulsar “Config”. 

Una vez se pulsa sobre uno de esos archivos, automáticamente se abrirá el 

editor de textos con el archivo en cuestión, para poderlo consultar o modificarlo 

a su antojo. Se desaconseja la manipulación de estos archivos a menos que 

sea un usuario experimentado, ya que se corre el riesgo de desconfigurar el 

servidor y por ende, su mal funcionamiento. 



10 
 

 Botón “Logs” 

 Al igual que con el botón anterior, si pulsamos sobre el botón “Logs” del 

servidor Apache, podremos consultar los diferentes archivos donde se 

almacenan automáticamente los logs que se van generando conforme va 

funcionando el servidor, donde quedan registrados las diferentes peticiones 

GET o POST que van realizándose en el servidor. 

En la siguiente ilustración se muestran los archivos que pueden abrirse al 

pulsar sobre “logs”: 

Ilustración 14: Detalle al pulsar “Logs”. 

Si por ejemplo pulsamos sobre Access.log, aparecerá el editor de textos 

siguiente: 

Ilustración 15: Archivo Access.log 

Los otros dos archivos, error.log y php_error_log, nos permiten consultar los 

diferentes errores que se producen en el servidor o bien en las funciones php 

ejecutadas en los diferentes scripts. 
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 1.2.2 Servidor MySQL 

 Botón “Admin” 

 Al pulsar dicho botón, inmediatamente se abre en el navegador el 

administrador de la base de datos, llevado a cabo mediante PhpMyAdmin, 

facilitando enormemente su manejo, ya que al ser visual su administración, es 

mucho más fácil e intuitiva. Observemos la siguiente ilustración: 

Ilustración 16: Administración de la base de datos. 

En la ilustración anterior puede observarse que en la parte izquierda se 

encuentran las diferentes bases de datos disponibles, en nuestro caso 

Androiddb es la usada en el proyecto. También puede observarse en la parte 

superior las diferentes opciones para consultar las diferentes tablas de las que 

dispone la base de datos, exportar/importar, etc.  

En la documentación del proyecto se incluye el archivo androiddb.sql el cual es 

la base de datos exportada con todos sus datos y tablas. Si queremos poner 

dicha base de datos en el administrador PhpMyAdmin, tan solo debemos pulsar 

sobre “importar”, buscar dicho archivo en el equipo y pulsar aceptar. 

Automáticamente aparecerá en el lateral izquierdo la base de datos que acaba 

de ser importada. 

Una vez pulsamos sobre la base de datos, podremos consultar sus diferentes 

tablas así como de los datos de que esta dispone, incluso se podrá modificar 
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sin ningún tipo de problema. En la siguiente ilustración se muestran las tablas 

de las que dispone la base de datos de nuestro proyecto: 

Ilustración 17: Tablas de la base de datos. 

Si pulsamos sobre una de las tablas, por ejemplo en útiles, aparecerá la tabla 

en cuestión, con toda su información, así como con las diferentes opciones de 

que dispone la tabla, tales como insertar algún elemento, su estructura interna 

o bien importar/exportar solo esta tabla. Todo esto aparece en la siguiente 

ilustración: 

Ilustración 18: Detalle tabla Útiles. 
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 Botón “Config” 

 Si pulsamos sobre el botón “config”, podremos acceder al archivo my.ini, 

que nos permite configurar diferentes aspectos de MySQL, aunque se 

desaconseja su manipulación a menos que nos encontremos con un usuario 

experimentado, ya que corremos el riesgo de que al manipular se produzca un 

mal funcionamiento del sistema. El menú que se muestra al pulsar sobre el 

botón indicado se muestra en la siguiente ilustración: 

Ilustración 19: Detalle al pulsar sobre botón “Config”. 

 Botón “Logs” 

 Al pulsar sobre dicho botón, aparecerá de nuevo un menú donde 

podemos pulsar sobre mysql_error.log, archivo de texto donde aparecerán los 

diferentes errores que se puedan producir en cuanto a MySQL. El menú 

desplegado se muestra en la siguiente ilustración: 

Ilustración 20: Detalle menú del botón “Logs”. 
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1.3 Parada de servidores 

Si en algún momento se desease parar los servidores, tan solo debe pulsarse 

sobre el botón “Parar”, que es el mismo botón que se usó para iniciar ambos 

servidores, tan solo que ha cambiado su utilidad. Observemos esto en la 

siguiente ilustración: 

Ilustración 21: Detalle botón parada ambos servidores. 

Una vez pulsados ambos botones de parada, observaremos abajo en los 

diferentes logs que aparecen, como ambos servidores se han detenido, 

indicando los PID relacionados con este hecho. Observemos dicho detalle en la 

siguiente ilustración: 

Ilustración 22: Detalle Logs generados al parar servidores. 
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2 Eclipse 

El entorno de desarrollo Eclipse, incluyendo sus plugins, está desarrollado por 

completo en el lenguaje Java. Un problema habitual en herramientas Java 

(como NetBeans) es que son demasiado “pesadas”. Es decir, necesitan una 

máquina muy potente para poder ejecutarse de forma satisfactoria. En gran 

medida, estas necesidades vienen determinadas por el uso de sus API para su 

interfaz gráfico. Sin embargo, en Eclipse se ha evitado este problema haciendo 

su instalación de manera modular, siendo el usuario el que elige qué plugins 

instalar y cuales no dependiendo de sus necesidades a la hora de programar o 

según las características que deba tener la aplicación a desarrollar. 

Es importante escoger cuidadosamente los plugins que se van a instalar pues, 

la cantidad de plugins instalados, influye en el rendimiento del IDE Eclipse, en 

especial, en el tiempo de arranque inicial de la aplicación. Es por ello no 

aconsejable instalar todos los plugins a la ligera, dado que afectará en el 

rendimiento de Eclipse, haciéndolo más lento, a menos que todos los plugins 

sean necesarios (cosa poco probable). 

Para añadir un nuevo plugin, basta con descomprimir el archivo descargado en 

el subdirectorio “Plugins” de la carpeta donde está instalado Eclipse. La 

próxima vez que se ejecute Eclipse, automáticamente, se reconocerán y 

añadirán los nuevos plugins instalados. 

2.1 Instalación de Eclipse 

La siguiente instalación vamos a dividirla en una serie de pasos: 

PASO 1: Descarga de Eclipse 

Aunque dentro de la documentación del proyecto se incluye el ejecutable para 

poder instalar Eclipse en Windows para el ordenador, se van a indicar los 
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pasos por si el lector desease descargar el ejecutable para otro sistema 

operativo como Linux o Apple, o bien porque pasado un tiempo quizás la 

versión incluida en la documentación quedase obsoleta y en la dirección que se 

indica a continuación se puede encontrar la versión más reciente. 

Desde la siguiente URL 

[http://www.eclipse.org/downloads/?osType=win32&release=undefined], se 

puede encontrar la versión más reciente y para todos los sistemas operativos: 

Ilustración 23: Pantalla elección descarga Eclipse enlace anterior. 

Desde el enlace anterior se accede al sitio Web donde se puede descargar el 

ejecutable de Eclipse, así como lo que denominan “Package solution”, donde 

se encuentran paquetes con los plugins más usados y necesarios a la hora de 

desarrollar una aplicación con Eclipse. Además tenemos la opción de poder 
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elegir sobre qué sistema operativo se va a ejecutar Eclipse, opción que puede 

en la parte superior derecha de la web, en este caso Windows, pero 

pudiéndose elegir Linux o Apple. 

Al pulsar sobre la opción deseada, nos saldrá la siguiente página: 

Ilustración 24: Pantalla descarga ejecutable Eclipse. 

Una vez se pincha sobre el enlace de descarga, comenzara la descarga 

inmediatamente: 

Ilustración 25: Detalle inicio descarga. 

Inmediatamente comenzará la descarga del ejecutable de Eclipse; si esto no 

ocurriese, pulsar sobre “click here” de la página anterior. 
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Una vez descargado el ejecutable, buscarlo en la carpeta de descargas:. 

Ilustración 26: Carpeta “descargas” donde se encuentra el ejecutable de Eclipse. 

Como puede observarse, se ha descargado la versión más reciente para 

Windows 32 bits, la versión 4.3.2. Otra cosa que se puede observar es que no 

se descarga un ejecutable, sino una carpeta comprimida donde se encuentra 

todos los directorios necesarios para ejecutar Eclipse.  

PASO 2: Instalación de Eclipse 

Si pinchamos sobre el archivo .rar, los directorios tienen el siguiente aspecto: 

Ilustración 27: Carpeta .rar comprimida con Eclipse. 
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Todas estas carpetas se deben descomprimir en un directorio único, llamado 

Eclipse, dentro del equipo. Se puede poner en cualquier parte del equipo, ya 

que no requiere instalación, dado que una vez se ha descomprimido en el 

directorio deseado, basta con hacer doble click sobre Eclipse.exe para 

comenzar a ejecutar el programa. En la ilustración 27 se ha resaltado el 

ejecutable Eclipse.exe, el cual es el que se debe pulsar para poder comenzar la 

ejecución de Eclipse. 

PASO 3: Iniciar Eclipse 

Una vez se han descomprimido todas las carpetas en el directorio deseado, 

como se dijo anteriormente, es suficiente con hacer doble click sobre el 

ejecutable Eclipse.exe de dicha carpeta para comenzar Eclipse: 

Ilustración 28: Detalle inicio Eclipse, cargándose. 
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2.2 Configuración de Eclipse 

Una vez se ha comenzado la ejecución de Eclipse, se van a mostrar 3 pasos 

fundamentales para el funcionamiento de Eclipse de manera óptima: 

 Descarga de Plugins. 

 Creación de un AVD. 

 Crear/Importar proyecto existente. 

  

 2.2.1 Descarga plugins 

 En primer lugar se recomienda la instalación del SDK (Software 

Development Kit) de Android que se encuentra disponible en la página oficial 

de Android developers [http://developer.android.com/sdk/index.html]. Este kit de 

desarrollo incluye un conjunto de herramientas tales como un debugger, 

librerías, un emulador, documentación, código de ejemplo y tutoriales. 

Ilustración 29: Descarga del SDK de Android para Eclipse. 
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La descarga básica del entorno Eclipse incluye algunos de los plugins más 

básicos, pero siempre es deseable obtener alguna funcionalidad extra. Para 

ello, es necesario instalar nuevos plugins.  

Se puede hacer de 2 formas: 

 1 -En el apartado Community del sitio web oficial de Eclipse se pueden 

encontrar enlaces a cientos de plugins [http://www.eclipse.org], como se 

muestra en la siguiente ilustración: 

Ilustración 30: Descarga de plugins desde página oficial. 

 2 –Desde el SDK instalado anteriormente para Eclipse, en el menú 

superior Window >Android SDK Manager: 

 

 

 

 

 

 

Ilustración 31: Descarga de plugins desde el propio Eclipse. 
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Al pulsar sobre dicha opción del menú, se cargarán los plugins instalados así 

como los no instalados, mediante una consulta al propio programa y a la web: 

Ilustración 32: Carga de plugins, instalados y no instalados. 

Una vez terminada la carga de los plugins, se muestra un menú con los nuevos 

plugins posibles de instalar, y tan solo seleccionando el o los plugins deseados 

y pulsando sobre “Install” es suficiente para comenzar dicha instalación, lo cual 

puede observarse en la siguiente ilustración: 

Ilustración 33: Selección e instalación de plugins. 
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Una vez instalados los nuevos plugins, se debe salir de Eclipse y volverlo a 

ejecutar para disponer de las nuevas funcionalidades aportadas por dichos 

plugins. 

 

 2.2.2 Creación de un AVD 

 Antes de iniciar la aplicación en Android es importante que tengamos 

disponible una AVD (Android Virtual Device) en Eclipse. 

Las AVD son unas herramientas imprescindibles para los desarrolladores y 

testers, ya que nos permiten emular en una computadora un entorno móvil a 

los que apuntará nuestra aplicación Android. Cuando recién hemos instalado el 

SDK (que incluye el AVD Manager) no contaremos con ningún dispositivo 

virtual. A continuación explicaremos en unos pasos como crear una AVD para 

poder emular la aplicación en el ordenador sin necesidad de llevarla a un 

dispositivo móvil físico. 

1. Abrimos el AVD Manager desde la opción Window > Android Virtual 

Device Manager: 

 

 

 

 

 

 

Ilustración 33: Detalle AVD Manager. 
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2. Elegimos la opción “Virtual devices” del panel situado a la izquierda y 

damos clic sobre el botón New: 

Ilustración 34: Inicio creación AVD. 

3. En la ventana Create new Android Device (AVD) llenaremos los 

siguientes campos: 

  Name:  El nombre que recibirá el dispositivo virtual y el que  

    aparecerá en la bandeja de dispositivos disponibles. 

  Target:  Es la versión de Android que correrá en el dispositivo 

    virtual. Esta versión deberá ser como mínimo la que  

    utilice el proyecto.  

 De forma opcional puedes llenar los campos: 

  SD Card:  Aquí configuramos lo relacionado con la SD Card.  

    Se puede seleccionar el tamaño deseado (en   

    este ejemplo le damos 1024 Mb). 
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  Skin:   Es la sección donde configuramos las características 

    de la pantalla del dispositivo (Tamaño). 

  Hardware: Opción de agregar características de hardware más  

    específicas del dispositivo que vayas a emular como  

    el acelerómetro, cámara, teclado físico, etc. 

En la siguiente ilustración se muestran los campos rellenos de todas las 

opciones anteriores: 

 

 

 

 

  

 

 

 

 

 

 

Ilustración 35: Pantalla edición AVD. 

Una vez seleccionadas y elegidas todas las características deseadas para 

nuestro AVD, aceptamos el nuevo dispositivo emulado AVD, mediante el cual 

podremos emular la aplicación sin necesidad de dispositivo físico. 
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4. Al aceptar el nuevo AVD, aparecerá en la lista de dispositivos creados: 

Ilustración 36: Nuevo AVD creado. 

5. En la ventana anterior, hacer click sobre el botón “Start”, donde 

aparecerá la siguiente pantalla: 

 

 

 

 

 

 

 

 

 

Ilustración 37: Inicio ejecución del AVD. 

Una vez pulsado “Launch”, comenzará a ejecutarse nuestro AVD, previa carga: 

 

 

 

Ilustración 38: Carga del AVD. 
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Ahora sí, podremos ver el aspecto de nuestro AVD: 

 

 

 

 

 

 

 

 

 

 

Ilustración 39: Aspecto AVD. 

En dicho dispositivo emulado, podremos instalar la aplicación, pudiendo hacer 

los cambios deseados en la aplicación en cualquier momento, haciendo la 

programación y desarrollo de la aplicación más fluida, ya que no hay que estar 

constantemente obteniendo el ejecutable de la aplicación e instalándolo en un 

dispositivo físico. 

 

 2.2.3 Crear/Importar proyecto existente. 

 En este último apartado, se explicará cómo crear un proyecto Android 

desde cero en unos simples pasos, para luego indicar como importar el 

proyecto completo que se encuentra en la documentación aportada. 
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Crear un proyecto nuevo 

Para crear un nuevo proyecto en Java con Eclipse pulsaremos en el menú 

File>New>Project, tal y como se muestra en la siguiente ilustración: 

Ilustración 40: Detalle abrir nuevo proyecto en Eclipse. 

Seguidamente, seleccionaremos el tipo de proyecto Java que queramos crear, 

en nuestro caso, "Android Application Project" y pulsaremos "Next": 

 

 

 

 

 

 

 

 

 

 

Ilustración 41: Elección del tipo de proyecto a crear. 
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Acto seguido, indicaremos tanto el nombre de la aplicación como el nombre del 

proyecto Java de Eclipse (en este ejemplo, ambos, "Proyecto Prueba"). 

También indicaremos el mínimo SDK deseado, así como el SDK objetivo de la 

aplicación, seleccionando el nivel de la API necesario para que la aplicación 

deseada funcione de manera óptima dependiendo de sus características. Por 

último pulsar "Next" para continuar con la creación y configuración del proyecto 

Java Eclipse: 

 

 

 

 

 

 

 

 

 

Ilustración 42: Selección nombre proyecto y nivel de API. 

Seguidamente aparecerá una nueva pantalla donde podremos seleccionar más 

opciones del proyecto creado, en este caso, seleccionar el directorio donde se 

almacenarán todos los datos relacionados con el nuevo proyecto dentro del 

equipo, por defecto, C:\Users\Usuario\workspace\ProyectoPrueba. Otras de las 

opciones a elegir es la creación automática del icono de la aplicación que se 

mostrará en el escritorio Android del Smartphone (aunque este icono podrá 
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cambiar de aspecto si se desea). Todo esto se muestra en la siguiente 

ilustración: 

Ilustración 43: Selección directorio del proyecto. 

Por último, se debe seleccionar el nombre de la actividad principal (Activity) 

creada, a partir de la cual se continuará con la aplicación: 

Ilustración 44: Creación primera Actividad del proyecto y finalización. 
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Con simplemente pulsar “Finish”, se creará el proyecto, que aparecerá entre los 

proyectos existentes en el entorno de trabajo, tal y como se muestra en la 

siguiente ilustración: 

 

 

 

 

Ilustración 45: Proyecto creado en el entorno de trabajo. 

Importar el proyecto de la documentación 

En este apartado, se indicará como importar un proyecto ya creado, en este 

caso, el proyecto completo de la aplicación Android creada y adjuntada en la 

documentación. El procedimiento es bastante sencillo, con tan solo seguir un 

par de pasos. En primer lugar pulsar File>Import, tal como se muestra: 

 

 

 

 

 

 

 

 

Ilustración 46: Importar proyecto. 
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Acto seguido, seleccionar “Proyecto existente en el entorno de trabajo”, donde 

previamente se ha copiado el archivo adjunto en la documentación dentro del 

equipo donde se desea cargar el proyecto. Luego pulsar “Next”: 

 

 

 

 

 

 

 

 

 

 

Ilustración 47: Selección de tipo de proyecto a importar. 

A continuación tan solo se debe seleccionar el proyecto a importar, buscándolo 

en la carpeta del equipo donde se haya colocado el proyecto adjunto de la 

documentación. Para ello, seleccionar la opción “Select Root Directory” o lo que 

es lo mismo, directorio raíz donde se encuentra el proyecto, para luego pulsar 

sobre “Browse”.  

Tras esto, se abrirá un submenú donde debemos buscar el proyecto, el cual 

una vez encontrado, se seleccionará y se pulsará aceptar. 
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Todo esto puede observarse en la siguiente ilustración, donde se muestra el 

menú donde encontraremos las opciones descritas anteriormente: 

 

 

 

 

 

 

 

 

 

Ilustración 48: Selección del proyecto adjunto en documentación. 

Una vez seleccionado el proyecto, pulsar en “Finish”, apareciendo el proyecto 

en nuestro entorno de trabajo: 

 

Ilustración 49: Detalle selección proyecto. 

Vista en el entorno de trabajo de Eclipse una vez importado el proyecto: 

 

 

 

Ilustración 50: Visto del proyecto importado. 
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3 Notepad ++ 

Al igual que con el resto de programas incluidos en la documentación, aunque 

se incluye un ejecutable del editor de textos Notepad++, puede que cuando se 

desee instalar el programa éste se encuentre obsoleto, por lo que en primer 

lugar se mostrará como descargarlo de su página oficial, para luego ver su 

instalación. 

3.1 Instalación de Notepad++ 

PASO 1: Descarga de Notepad++ 

Para descargar el programa en su última versión, se puede visitar el sitio oficial 

de dicho programa, [http://notepad-plus-plus.org/], desde donde puede 

descargar la versión más reciente del momento, tal como se muestra en la 

siguiente ilustración: 

Ilustración 51: Sitio oficial para descarga de Notepad++. 

En la ilustración anterior se muestra el sitio oficial de descarga del programa, 

resaltándose la versión más actual en el momento de la creación de este 

proyecto (Notepad++ 6.6.2, Mayo 2014). 
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Una vez seleccionada la versión deseada para descargar, proceder a su 

descarga, pulsando sobre “Download”, tal y como se muestra en la ilustración 

siguiente: 

Ilustración 52: Detalle página descarga. 

PASO 2: Instalación de Notepad++ 

Para iniciar la instalación de Notepad++, ejecuta el archivo adjunto en la 

documentación o el archivo descargado si la versión adjunta quedó obsoleta 

(npp.6.6.2.Installer.exe). Comenzará preguntándote por el idioma: 

 

 

 

Ilustración 53: Selección del Idioma. 
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Inmediatamente comenzará el asistente de instalación: 

Ilustración 54: Asistente instalación. 

Se seleccionará el directorio donde se desea realizar la instalación: 

 

 

 

 

 

Ilustración 55: Directorio de instalación. 

Seleccionar las opciones de instalación deseadas (dejarlas por defecto): 

 

 

 

 

 

Ilustración 56: Selección de opciones de instalación. 
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Por último, pulsar en “Instalar”, para llevar a cabo la instalación: 

 

 

 

 

 

 

 

 

Ilustración 57: Comenzar instalación con las opciones seleccionadas. 

 

3.2 Inicio de Notepad++ 

Una vez instalado, podremos iniciar el programa buscándolo en el directorio del 

equipo donde lo hayamos instalado o en el acceso directo creado en el 

escritorio, mediante el cual podremos consultar o editar los archivos php 

adjuntos en la documentación si se desease: 

Ilustración 58: Aspecto Notepad++. 


